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Saver EVO bruksanvisning
Saver EVO-programvaren gjør det mulig for deg å hente defibrilleringshendelsesdata fra HeartSine samaritan PAD og 
PDU-minnekortet. Saver EVO vil også gjøre det mulig for deg å behandle hendelsesdata som er lagret på datamaskinen 
med hensyn til å skrive ut, importere og eksportere hendelsesdata til andre Saver og Saver EVO-brukere.

Saver EVO leveres med programvarelisens for installasjon og bruk av programvaren på én datamaskin med Microsoft 
Windows (fortrinnsvis Windows 10).

Nedlasting fra nettsiden
Installasjon av Saver EVO kan kreve administratortillatelse – om nødvendig kontakt systemadministratoren/IT-
tjenesteleverandøren din.

1. Gå til heartsine.com for å laste ned Saver EVO-programvaren for din region.

2. Etter nedlasting kjør  SaverEVO_setup.exe for å installere Saver EVO. (Følg anvisningene på skjermen.)

3.  Les brukerlisensavtalen. For å installere denne programvaren må du samtykke i avtalebetingelsene. For å godta 
betingelsene klikk på «Next» (Neste).

4.  Saver EVO installeres på standard plassering med standard konfigurasjon. Klikk på «I agree» (Jeg godtar) for å godta. 
Disse standardinnstillingene bør ikke endres med mindre du er en erfaren datamaskinbruker.

5.  Hvis du blir spurt to ganger om enhetsdriversertifikatet, klikk «Continue anyway» (Fortsett likevel).

Hurtigstartveiledning
For å hente defibrilleringshendelsesdata fra HeartSine samaritan PAD eller PDU-minnekortet.

1.  Koble den aktuelle enheten til datamaskinen.

2.  Åpne Saver EVO-programvaren.

3.  Klikk på knappen  eller .

4.  Klikk på knappen  for å vise en liste over lagrede hendelser.

5.  Merk den ønskede lagrede hendelsen i listen.

6.  Klikk på knappen  for å vise hendelsen.

7.  Klikk på knappen , og angi pasientinformasjonen slik du blir bedt om for å lagre hendelsen på datamaskinen. 

8.  Hvis nødvendig klikk på  for å skrive ut hendelsesregisteret.
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Slik bruker du Saver EVO 
Startskjermen til Saver EVO vises nedenfor.

Startskjermen til Saver EVO

samaritan PAD
Åpner menyen for funksjonene spesifikke for HeartSine samaritan PAD. Se side 4 
for detaljer

samaritan PDU Åpner menyen for funksjonene spesifikke for PDU. Se side 9 for detaljer

Manage Saved Events 
(Administrer lagrede 
hendelser)

Åpner menyen for funksjonene spesifikke for hendelsene lagret på datamaskinen. 
Se side 12 for detaljer

Exit Saver EVO (Avslutt 
Saver EVO)

Avslutter Saver EVO-programvaren

Endre Saver EVO-passordet
Endre Saver EVO-passordet, og velg språk. Lar også brukeren vise informasjon 
om revisjon av Saver EVO

Bruken av de spesifikke menyene ovenfor vil beskrives mer detaljert nedenfor.

Slik bruker du Saver EVO med HeartSine samaritan PAD
For å bruke Saver EVO med HeartSine samaritan PAD trenger du USB-datakabelen (som kanskje ble levert med 
HeartSine samaritan PAD). Hvis du ikke har kabelen, kontakt Stryker-salgsrepresentanten eller autorisert distributør. 

Hvis en HeartSine Gateway er koblet til AED-en, kan du bruke en mikro-USB-kabel.

1. Koble USB-datakabelen til HeartSine samaritan PAD og til USB-porten på datamaskinen. Åpne Saver EVO-
programvaren.

Saver EVO 1.3.0 Bruksanvisning
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2. Hvis du klikker på «samaritan PAD»-knappen, åpnes vinduet som er vist nedenfor.

Skjerm for tilgang til Saver EVO PAD

PAD Data (PAD-data)
Klikk denne knappen for å hente hendelsesdata fra HeartSine samaritan PAD. Se 
side 5 for detaljer

Change PAD Settings (Endre 
PAD-innstillinger)

Klikk på denne knappen for å kjøre diagnosetester eller for å endre 
konfigurasjonen (vo lum og tid) på HeartSine samaritan PAD. Se side 7 for detaljer

Back (Tilbake) Klikk denne knappen for å gå tilbake til startskjermen til Saver EVO

Slik henter du hendelsesdatainformasjon fra HeartSine samaritan 
PAD
For å hente defibrilleringshendelsesdata fra HeartSine samaritan PAD kontroller at HeartSine samaritan PAD er koblet 
til datamaskinen og klikk på «PAD Data» (PAD-data). Da søkes det i minnet til HeartSine samaritan PAD, og alle lagrede 
hendelser listes opp og vises slik det fremgår nedenfor.

Skjermen for Saver EVO PAD-hendelsesloggliste

Saver EVO 1.3.0 Bruksanvisning
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Hendelser vist i grønn tekst med et -symbol er hendelser som allerede er lagret på datamaskinen.

Save All (Lagre 
alt)

Hvis klikker på «Save All» (Lagre alt), vil alle hendelsesfilene oppført i PAD-hendelsesloggen 
lagres til datamaskinen i én enkelt fil

Merk: Hendelser lagret med denne metoden kan ikke åpnes for visning av denne versjonen 
av Saver EVO. For å åpne hendelser fra denne filen kontakt kundeservice hos HeartSine 
Technologies. For å lagre hendelser individuelt for senere åpning se informasjon om  
Lagre-funksjonen i Slik viser du hendelser på en HeartSine samaritan PAD på side 6

View (Vis) Når du klikker på denne knappen, vises den valgte hendelsen

Erase (Slett)
Hvis du klikker på denne knappen, slettes alle hendelsene fra HeartSine samaritan  
PAD-hendelsesloggen. Se side 7 for mer detaljert informasjon om sletting av data

Back (Tilbake) Klikk denne knappen for å gå tilbake til skjermen for tilgang til Saver EVO PAD

Slik viser du hendelser på en HeartSine samaritan PAD
1. For å vise en hendelse merk hendelsen i listen og klikk «View» (Vis). Dette vil vise defibrilleringshendelsen med  

EKG-kurven og hendelsesloggen i et enkelt visningsvindu.

Vinduet pasientdetaljer for Saver EVO PADHendelsesvisningsvindu for Saver EVO PAD

2. Du kan nå velge å lagre den viste hendelsen til datamaskinen ved å klikke «Save» (Lagre). Hendelser som lagres med 
denne metoden, kan åpnes og vises på Saver EVO. Du får alternativet om å angi informasjonen som gjør det mulig 
å identifisere pasienten fra listen over lagrede hendelser på datamaskinen. Detaljene om pasienten kan bestå av 
alfanumeriske tegn, og hvert felt kan fylles ut eller la være tomt etter behov.

Merknad: Når defibrilleringshendelsesdataene er lagret på datamaskinen, kan ikke denne informasjonen endres

Saver EVO 1.3.0 Bruksanvisning
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Hendelsesvisningsvinduet på Saver EVO har også de følgende knappene: 

Print (Skriv ut) Klikk denne knappen for å skrive ut hendelsen som når vises i visningsvinduet

Print Preview 
(Forhåndsvisning av utskrift)

Klikk denne knappen for å forhåndsvise utskriftsdataene på skjermen

Back (Tilbake)
Klikk denne knappen for å gå tilbake til skjermen for Saver EVO PAD-
hendelsesloggliste

Slik sletter du minnet på en HeartSine samaritan PAD
1. For å slette minnet til en HeartSine samaritan PAD klikk «Erase» (Slett). 

2. Saver EVO ber deg om å angi passordet før minnet slettes som en forsiktighetsregel. Når det riktige passordet er 
angitt, slettes minnet til HeartSine samaritan PAD. For informasjon om hvordan du endrer standard passord se 
Endring av Saver EVO-passordet på side 14. 

 Det anbefales at hendelsene slettes fra minnet til HeartSine samaritan PAD når hendelsesdataene hentes 
fra HeartSine samaritan PAD og lagres på datamaskinen. Dette vil sikre at hele minnet er tilgjengelig for 
registrering av data fra en annen defibrilleringshendelse.

 Forsiktig: HeartSine anbefaler at du laster ned hele minnet fra HeartSine samaritan PAD før du sletter det. Denne 
informasjonen skal lagres sikkert for fremtidig referanse

Slik endrer du innstillingene på HeartSine samaritan PAD
Knappen «Change PAD Settings» (Endre PAD-innstillinger) lar brukerne konfigurere noen funksjoner på HeartSine 
samaritan PAD som følger:

• Sjekk/innstill tid

• Kjør diagnosetester

I tillegg kan brukere med tilstrekkelige rettigheter endre følgende innstillinger:

• Volum

• Aktiver/deaktiver metronomlyd

1. Ved å klikke på «Change PAD Settings» (Endre PAD-innstillinger) får du tilgang til følgende skjerm:

Skjermen for å endre Saver EVO PAD-innstillinger

Saver EVO 1.3.0 Bruksanvisning
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Check/Set PAD Time (Sjekk/innstill PAD-tid)
Denne knappen lar brukerne synkronisere klokkeslettet på HeartSine samaritan PAD med klokkeslettet på 
datamaskinen.

Skjermen for å sjekke/stille inn PAD-tid på Saver EVO

1. Klikk «Synchronize» (Synkroniser) for å stille inn klokken på HeartSine samaritan PAD til det samme klokkeslettet 
som på den tilkoblede datamaskinen.

2. Klikk «Close» (Lukk) for å gå tilbake til skjermen Endre PAD-innstillinger på Saver EVO.

Run Diagnostic Tests (Kjør diagnosetester)
Denne knappen lar brukere kjøre noen grunnleggende tester for å kontrollere at HeartSine samaritan PAD fungerer. Du 
åpner listen over tilgjengelige diagnosetester via nedtrekksmenyen slik som vist nedenfor.

Vinduet diagnosetester for Saver EVO PAD

Saver EVO identifiserer PAD-enheten som er koblet til, og viser tilhørende illustrasjoner for å veilede brukeren gjennom 
testene. 

Saver EVO 1.3.0 Bruksanvisning
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Edit PAD Configuration (Rediger PAD-konfigurasjon)
Klikk denne knappen for å åpne skjermen Rediger PAD-konfigurasjon (vist nedenfor) hvor du kan vise og endre volum- 
og metronominnstillingene og vise programvareversjon for den tilkoblede HeartSine samaritan PAD-enheten. For å 
bekrefte disse endringene blir du bedt om å angi Saver EVO-passordet. For informasjon om hvordan du endrer standard 
passord se Endring av Saver EVO-passordet på side 14.

Skjermen for å endre Saver EVO PAD-konfigurasjon

Slik bruker du Saver EVO med PDU*
1. For å bruke Saver EVO med samaritan PDU-minnekortet må du sette kortet inn i en MMC-SD-kompatibel kortleser 

som enten er koblet til eller bygget inn i datamaskinen som driver Saver EVO. Merk at det kan ta noen sekunder, 
eller mer enn ett minutt, før datamaskinens operativsystem oppdager at kortet er til stede i kortleseren. 

2. Klikk «samaritan PDU»-knappen fra startskjermen. Da åpnes vinduet nedenfor.

Skjerm for tilgang til Saver EVO PDU

* samaritan PDU var ikke tilgjengelig i USA, og er ikke lenger et produkt som tilbys av HeartSine.
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PDU Data (PDU-data)
Klikk denne knappen for å hente hendelsesdata fra PDU-minnekortet. Se side 10 for 
detaljer

PDU Settings  
(PDU-innstillinger)

Klikk denne knappen for å vise konfigurasjonsinnstillingene. Se side 12 for detaljer

Back (Tilbake) Klikk denne knappen for å gå tilbake til startskjermen til Saver EVO

Slik henter du hendelsesdata fra PDU-minnekortet
Kontroller at samaritan PDU-minnekortet er satt i SD/MMC-kortleseren, og klikk knappen «PDU Data» (PDU-data). Da 
listes hendelsene som er lagret på minnekortet.

Skjermen for Saver EVO PDU-hendelsesloggliste

Hendelser med klokkesymbolet  er PDU-selvtester som ble vellykket fullført.

Hendelser vist i grønn tekst med et -symbol er hendelser som allerede er lagret på datamaskinen.

Save All (Lagre alt) Denne knappen er deaktivert i PDU-m odus

View (Vis) Når du klikker på denne knappen, vises den valgte hendelsen. Se side 11 for detaljer

Erase (Slett) Denne knappen er deaktivert i PDU-modus

Back (Tilbake) Klikk denne knappen for å gå tilbake til skjermen for tilgang til Saver EVO PDU

Saver EVO 1.3.0 Bruksanvisning
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Slik viser du hendelser lagret på en PDU 
1. For å vise en hendelse merk hendelsen i listen og klikk «View» (Vis). Dette vil vise defibrilleringshendelsen med EKG-

kurven og hendelsesloggen i et enkelt visningsvindu:

Hendelsesvisningsvindu for Saver EVO PDU

2. Brukeren kan nå velge å lagre den viste hendelsen til datamaskinen ved å klikke «Save» (Lagre). Du får alternativet 
om å angi informasjonen som gjør det mulig å identifisere pasienten. Detaljene om pasienten kan bestå av 
alfanumeriske tegn, og hvert felt kan fylles ut eller la være tomt etter behov.

Vinduet pasientdetaljer for Saver EVO PDU

Merk: Når defibrilleringshendelsesdataene er lagret på datamaskinen, kan ikke denne informasjonen endres

Hendelsesvisningsvinduet på Saver EVO har også de følgende knappene: 

Print (Skriv ut) Klikk denne knappen for å skrive ut hendelsen som når vises i visningsvinduet

Print Preview 
(Forhåndsvisning av utskrift)

Hvis du klikker denne knappen, vises forhåndsvisningen av utskriftsdataene på 
skjermen

Back (Tilbake)
Klikk denne knappen for å gå tilbake til skjermen for Saver EVO PDU-
hendelsesloggliste

Saver EVO 1.3.0 Bruksanvisning



12  |  Saver EVO

Vise PDU-innstillinger
Hvis du klikker på «PDU Settings» (PDU-innstillinger), åpnes følgende PDU-konfigurasjonskjerm. Denne skjermen 
lar brukeren vise batteristrøm, høyttalervolum, språk og metronominnstillinger, HLR-frekvens og varighet samt 
utløpsdato, programvareversjon og serienummeret til PDU-enheten. Brukeren kan bare vises disse innstillingene, men 
ikke foreta endringer.

Skjermen for å vise Saver EVO PDU-innstillinger

Slik bruker du Saver EVO med lagrede hendelser
Knappen «Manage Saved Events» (Administrer lagrede hendelser) på hovedskjermen til Saver EVO lar brukerne 
gå gjennom hendelsesdata som er lastet ned fra HeartSine samaritan PAD, samaritan Data-Pak-batteri eller PDU-
minnekort og lagret til datamaskinen. 

1. Når du klikker på knappen, åpnes et vindu som følger:

2. Hvis du merker en lagret hendelse i listen og klikker «View» (Vis), åpnes den lagrede hendelsen og viser EKG-data og 
hendelseslogg.

Saver EVO 1.3.0 Bruksanvisning
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Eksport og import
Saver EVO har funksjoner som gjør det mulig for brukerne å sende eller motta defibrilleringshendelsesdata fra andre 
personer som har Saver EVO-programvaren. For å sende eller motta kopier av lagrede hendelser bruk eksport- og 
importfunksjonene i Saver EVO.

For å eksportere hendelser:
1. Fra skjermen Administrer lagrede hendelser merk hendelsen eller hendelsene du ønsker å eksportere, og klikk 

deretter «Export» (Eksporter).

2. Datamaskinen vil be om en plassering på datamaskinen som du ønsker å lagre eksportfilen på, og lar deg også velge 
et navn for den eksporterte filen.

3. Klikk «Save» (Lagre) for å lagre filen på valgt plassering.

Det er da mulig å vedlegge denne filen i en e-post når du bruker ditt vanlige e-postprogram og sender den eksportere 
filen til en annen bruker som har Saver EVO-programvaren.

Hendelsesdata fra Saver EVO kan bare vises av en annen Saver EVO-bruker. Den tidligere Saver-programvaren kan ikke 
importere og vise data fra Saver EVO.

For å importere hendelser:
For å importere hendelser og vise disse på datamaskinen må filen som er sendt til deg fra en annen bruker av Saver eller 
Saver EVO lagres på en plassering på datamaskinen.

1.  Fra skjermen Administrer lagrede hendelser klikk på «Import» (Importer).

2. Bla til plasseringen hvor filen ble lagret, og klikk «Open» (Åpne).

3. Registreringene vil legges til listen av Saver EVO-filer på datamaskinen.

Disse kan deretter vises ved å merke hendelsen i listen og klikke «View» (Vis).

Saver EVO vil importere og vise hendelsesdata som er blitt eksporter fra tidligere versjoner av 
programvaren kalt Saver på riktig måte.

Sletting av lagrede hendelser:
Lagrede hendelser kan slettes fra datamaskinminnet av Saver EVO. Hendelser slettes individuelt ved å velge 
hendelsen(e) som skal slettes (flere hendelser kan velges) ved å merke den aktuelle hendelsen. 

Når du har bekreftet at bare hendelsene du ønsker å slette, er valgt, klikk «Erase» (Slett). Saver EVO ber deg om å angi 
passordet før minnet slettes som en forsiktighetsregel. Når det riktige passordet er angitt, slettes valgte hendelser fra 
minnet til datamaskinen.

 Forsiktig: Kontroller at bare hendelsene du ønsker å slette, er valgt før sletting. Etter at hendelsene er slettet fra 
datamaskinens minne, kan de ikke gjenopprettes, og all informasjon går tapt  
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Endring av Saver EVO-innstillinger
Saver EVO har noen funksjoner som bare kan endres eller foretas ved å angi et passord. Dette gjør det mulig for 
administratorer å begrense tilgangen til visse funksjoner bare for autoriserte brukere. Ved installasjon av Saver EVO er 
standard passord «password».

Endring av passordet:

1. Fra hovedskjermen på Saver EVO klikker du på den lille knappen «Innstillinger». Da åpnes det følgende vinduet:

Skjermen Endre Innstillinger

2.  Angi det aktuelle passordet, og klikk «Confirm» (Bekreft).

3. Angi det nye passordet to ganger, og klikk deretter «Apply» (Bruk) for å foreta endringen.

4.  Klikk «OK» for å lukke skjermen for endring av passord.

Merk: Ved å installere Saver EVO på nytt tilbakestilles passordet til standard. Denne handlingen fjerner imidlertid 
ikke hendelsesdata som tidligere var lagret

Saver EVO 1.3.0 Bruksanvisning
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Endring av språket på Saver EVO: 
1. For å velge språket for Saver EVO velg språket fra rullegardinlisten, og klikk «Apply» (Bruk).

2. Ved å klikke på «Apply» (Bruk) vises neste skjerm og Saver EVO må startes på nytt for at språkendringene skal tre i 
kraft.

3. Klikk henholdsvis «Yes» (Ja) eller «No» (Nei) for å lukke Saver EVO.

Sjekk av automatiske oppdateringer:
1. Hvis boksen «Enable» (Aktivert) er valgt hver gang Saver EVO startes, vil programmet forsøke å koble til nettstedet 

til HeartSine for å se etter nyere versjoner av Saver EVO. Hvis en oppdatering finnes, blir du varslet med det 
følgende vinduet når Saver EVO startes.

2. Klikk henholdsvis «Yes» (Ja) eller «No» (Nei) hvis du ønsker å laste ned en nyere versjon av Saver EVO.

Saver EVO 1.3.0 Bruksanvisning



Nettsikkerhet
• Kontroller at alle sikkerhetsoppdateringene fra Microsoft er installert på datamaskinen

• Sikkerhetskopier datamaskinen regelmessig (inkludert Saver EVO-filer)

• Det anbefales at du installerer, aktiverer og holder antivirusprogramvare og beskyttelse mot skadelige programmer 
oppdatert på datamaskinen

• Bruk et sterkt passord for å logge deg på datamaskinen. Passordet bør inkludere store og små bokstaver samt tall og 
symboler

For mer informasjon ta kontakt med oss på heartsinesupport@stryker.com eller besøk  
vår nettside heartsine.com

Stryker eller deres datterselskaper eier, bruker eller har søkt om å registrere følgende varemerker eller servicemerker:  
HeartSine, HeartSine Gateway, samaritan, Saver EVO, Stryker.  Alle andre varemerker er varemerker som eies av deres 
respektive eiere eller innehavere.

Utstedelsesdato: 09/2023
Laget i Storbritannia.
H013-001-309-AE  NO
HeartSine Gateway er ikke tilgjengelig i alle land.
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